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What’s New for
Avid® Media Composer® | Software v8.1

New Features

The following table describes What’s New for the current editor release.

Feature Description For More Info

AAX-64 The editing application supports AAX-64 
(Avid Audio eXtension) plug-ins. 

See “AAX Plug-In Support” on 
page 3.

Exporting MXF OP1a The Avid editing application supports 
exporting DNxHD as MXF OP1a wrapped 
media.

See “Exporting MXF OP1a” on 
page 6.

Frame View Border Colors 
and Icons

The editing application allows you to show 
border colors in Frame View based on either 
the object type or clip color. Icons can also be 
shown in Frame View.

See “Frame View Border Colors 
and Icons” on page 7.

Filter Out AMA Media in 
the Media Tool

The editing application allows you to filter 
out AMA media in the Media Tool. 

See “Filter AMA Media in the 
Media Tool” on page 8.

Placing a Title in the 
Timeline

The option allows you to place a saved title in 
the Timeline between a Mark In and Mark 
Out.

See “Place a Saved Title in the 
Timeline” on page 9.

Changes to dragging in the 
User Interface

For consistency when using Shift and drag in 
the User interface, changes were made to 
Shift + dragging a segment and Shift + 
dragging the Trim Roller.

See “Changes to Dragging in the 
User Interface” on page 9.

Copy Drag Segment You can now copy drag a segment. See “Copying and Dragging 
Segments” on page 9.

Support for ARRI® AMIRA 
camera 

This release supports using the ARRI 
AMIRA camera.

See “Color Management Support 
for ARRI AMIRA Camera 
Embedded Looks” on page 10.
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Muting Individual Clips in 
the Timeline

The editing application allows you to mute 
individual video and audio clips in the 
Timeline.

See “Muting Individual Clips in 
the Timeline” on page 10.

Disabling a Video Track The editing application allows you to disable 
a video track in the Timeline.

See “Disabling a Video Track” on 
page 11.

Multiple Audio Mixdowns The editing application allows you to 
generate multiple audio mixes.

See “Mixing Down Multiple 
Audio Tracks” on page 12.

Group clip support for 
Stereoscopic clips

You can now make group clips that contain 
stereoscopic clips. 

See “Grouping Stereoscopic 
Clips” on page 15.

Setting for Selecting Filler You can choose whether or not you want filler 
to be selected when using the Segment Tools.

See “Selecting Filler with 
Segment Tools” on page 15.

Extending Shift Trim This feature makes adding/removing trim 
rollers in Trim Mode easier. Use the Shift key 
while selecting a segment in Trim Mode to 
add a trim roller.

See “Extend Shift Trim Click” on 
page 16.

End of Trim Indicators The editing application adds a bracket to the 
trim indicator so you can identify which track 
ran out of footage to trim.

See “End of Trim Indicators” on 
page 16.

Merging Source Segment 
and Program Segment 
Color Correction 

You can merge Color Correction that was 
created using the Source Segment or Program 
Segment relationship. Color corrections using 
Source or Program segment relationships will 
be merged using the Segment’s source and 
timecode.

See “Merging Color-Corrected 
Sequences (Symphony Option)” 
on page 17.

Avid Image Sequencer 
Plug-In

The Avid Image Sequencer Plug-in allows 
you to AMA Link to DPX files.

See “Avid Image Sequencer” on 
page 20.

Settings Changes An AMA Setting was added and a Media 
Creation Setting was updated.

See “Settings Updates” on 
page 25.

Feature Description For More Info
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AAX Plug-In Support

The editing application supports AAX-64 (Avid Audio eXtension) plug-ins. AAX plug-ins are 
audio effects that you apply (or insert) on tracks, on your sequence. These inserts let you process 
audio material on a track in real time so that you can apply the effects to a sequence and play 
them back or output them without rendering them first. These are the same AAX audio effects 
that Avid Pro Tools® also supports. This plug-in architecture was created to support 64-bit 
processing. The AAX plug-ins replace RTAS plug-ins. Many RTAS plug-in parameters have 
been mapped to the available AAX parameters. Therefore you can move sequences forward 
without re-tweaking parameters. However, there are a small number of plug-ins that do not have 
an equivalent AAX replacement:

• No replacement for these AudioSuite plug-ins: BF Essential Clip Remover, Chorus, 
Flanger, Delay, Mutli-Tap Delay, Ping-Pong Delay

• No replacement for these RTAS plug-ins: Extra Long Delay II, Long Delay II, Medium 
Delay II, Short Delay II, Slap Delay II, EQ3 4-Band, Phase Scope, SurroundScope

n We recommend that you replace the Chorus, Flanger, and other delay effects with the new AAX 
Delay plug-in.

However, there are a number of new plug-ins: 

• New for AudioSuite: Channel Strip, Eleven Free, Maxim, Mod Delay III, SansAmp PSA-1

• New for Track Effects: Channel Strip, Eleven Free, Maxim, Mod Delay III, SansAmp, 
PSA-1, Dither, POW-r Dither, DownMixer

n For descriptions and details on the new plug-ins, see “Using Audio Plug-Ins” in the Help.

A number of 3rd party vendors are moving from RTAS plug-ins to AAX plug-ins. Contact your 
3rd party vendor to see if their AAX plug-ins are available.

c IMPORTANT: These new AAX plug-ins effectively replace the existing RTAS and 
AudioSuite plug-ins available in previous versions of Media Composer. Media Composer 
8.1 will install AAX replacements that are fully compatible with the RTAS and AudioSuite 
plug-ins that were provided by default in previous versions of Media Composer. RTAS and 
AudioSuite plug-ins that you may have purchased on your own are NO LONGER 
COMPATIBLE with this and future versions of Media Composer. In most cases, you will 
be able to obtain fully compatible AAX replacements for these. If you have purchased 
RTAS and/or AudioSuite plug-ins that are used in your workflow, please visit 
http://www.avid.com/plugins to find compatible AAX plug-ins from the vendor that you 
purchased them from BEFORE YOU UPGRADE TO THIS or FUTURE VERSIONS OF 
MEDIA COMPOSER. 

http://www.avid.com/plugins
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n Media Composer now has delay compensation, so that plug-in processing delays won't introduce 
A/V sync slip. 

AAX Plug-Ins

The process for inserting an AAX Plug-In is the same process you used for inserting an RTAS 
plug-in:

Inserting an AAX Plug-In on a Track in the Timeline

You can insert up to five plug-in track effects (inserts a through e) on an audio track. When you 
insert a plug-in effect to a track, you select the track where you want to apply the effect, which 
insert location you want to use on the track, and the specific effect you want to add to your 
sequence.

To insert an AAX plug-in from the Timeline, do the following:

t Right-click the Record Track button or the Track Control panel for the track where you want 
to apply the insert and select Audio Track Effects [track number] > Insert [a-e] > [insert].

The plug-in effect is inserted in the track.

To insert an AAX plug-in using the Audio Track Effect insert button, do the following:

1. Click an Audio Track Effect insert button in the Track Control panel for the track where you 
want to apply the insert.

The Audio Track Effect Tool opens.

2. Click the Select Effect button, and select a plug-in effect:

The plug-in effect is inserted in the track.

To insert an AAX plug-in using the Effect Palette:

1. In the Project window, click the Effects tab.

The Effect Palette appears.
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2. Click the Audio tab.

3. Select the effect you want, and drag it to the segment or to the insert button where you want 
to apply the insert. You can only insert mono effects on a mono track, stereo effects on a 
stereo track, and surround sound effects on a surround sound track.

The Select Insert dialog box opens.

4. Do one of the following:

t If you want to add a new insert, click an [Empty] insert button.

t If you want to replace an existing insert, click the appropriate insert button.
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The plug-in effect is inserted in the track to which you dragged the effect icon.

Exporting MXF OP1a

The Avid editing application supports exporting DNxHD as MXF OP1a wrapped media. Up to 
16 channels of output and ancillary data are supported.

To export a sequence or master clip as MXF OP1a:

1. Select the sequence or master clip you want to export as MXF OP1a.

2. Click File > AMA File Export, or right click the sequence and select AMA File Export.

The AMA File Export dialog opens.

3. Select File Type MXF OP1a Export.

4. (Option) Select the Use Marks or Use Enabled Tracks option.

t When you select Use Marks, your Avid editing application uses current IN and OUT 
points in the selected clip or sequence to determine starting and ending frames for the 
export. To export the entire clip or sequence, deselect this option or mark the entire clip 
or sequence.
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t When you select Use Enabled Tracks, your Avid editing application exports the tracks 
that are enabled in the Timeline. To export all the tracks in the sequence, deselect this 
option.

5. Click the Directory Set button to and browse to the location where you want the file saved.

6. Click Select Folder.

7. Select the Video Compression, Audio Sample Rate, Bit Depth and Audio format.

8. Click Save. 

The MXF OP1a file is exported to the selected directory.

Frame View Border Colors and Icons

The editing application allows you to show border colors in Frame View based on either the 
object type or clip color. Icons can also be shown in Frame View.

To set Frame View border colors:

1. Click the Settings tab in the Project Window.

2. Double-click Bin.

The Bin Settings dialog opens.

3. In the Frame View pane select Show Border Colors.
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4. Select one of the following options:

5. Click OK.

The applicable borders and icons will appear in the bin when in Frame View.

Filter AMA Media in the Media Tool

The editing application allows you to filter out AMA media in the Media Tool. 

To filter out AMA Media in the Media Tool

1. Select Tools > Media Tool.

2. If you want AMA Master clips to appear in the Media Tool, make sure the AMA Master 
Clips option is selected. If you do not want AMA media from appearing in the Media Tool, 
deselect AMA Master clips.

n You can also choose to filter out AMA media from the Bin. Select Set Bin Display from the Bin 
Menu and deselect AMA Media.

Option Description

Use color based on 
object type

When selected, a colored border appears around the following:

• Blue - Precomputes and source side motion effects

• Green - Master clips

• Dark Green - Subclips and Group clips

• Red - Sequences

• Purple - Media files in the Media Tool

Use clip Color If you assigned colors to items in the bin in Text View, these same 
colors will be used as a border for the bin item when in Frame View.

Show icons The applicable bin item icon, for example sequence, clip, subclip, 
title, etc. will appear in Frame View.
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Place a Saved Title in the Timeline

The editing application allows you to save a title and automatically place it between an In and 
Out mark in the Timeline.

To save a title and place it between In and Out marks in the Timeline:

1. Make sure you have an In and Out mark in your Timeline.

2. Select File > Save Title.

The Save Title dialog box opens.

3. Enter a name for the title.

4. Select the Place in Timeline (In -> Out) option.

5. Select the track where you want to place the title. The tracks listed are based on the tracks 
available for the current sequence.

6. Click Save.

The title is placed in the Timeline between the In and Out marks.

Changes to Dragging in the User Interface

The following changes have been made when dragging in the User Interface.

• Pressing Shift while dragging the Trim Roller, fine-tunes movement.

• Pressing Shift while dragging a segment, fine-tunes movement. (This functionality used to 
be on the Alt (Windows) Option (Mac) modifiers when dragging a segment. Now, Alt 
(Windows) Option (Mac) is used for copy drag (see “Copying and Dragging Segments” on 
page 9).

Copying and Dragging Segments

Simply use Option (Mac) or Alt (Windows) while dragging a segment to copy the segment.

To copy and drag a segment:

1. Using a segment tool, click and hold the segment you want to copy and drag.

2. Press Option (Mac) or Alt (Windows) and drag the segment.

A plus sign (+) should appear in the segment if you have selected it properly for a copy drag. 
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3. Drop the copied segment in the new position in the Timeline. 

Color Management Support for ARRI AMIRA Camera 
Embedded Looks

The AMIRA camera has the capability to embed a “look” (LUT and CDL) into each of the 
QuickTime ProRes files that it produces. Depending on the recording mode on the camera, this 
Look can be included in the media file as a “final” Rec.709 clip. It can also be saved as a LogC 
clip with the added metadata (and the LUT) describing the color transformation to recreate that 
Look in another application. 

Media Composer recognizes both ARRI LogC and Rec. 709 color spaces and applies (when 
enabled in the color management settings) the proper transformation to Rec.709 for the LogC 
ones. Furthermore, if the LogC clips also include metadata about a Look (LUT and CDL), those 
transformations will also be applied during the conversion to Rec.709. Any applied 
transformations can be seen in the color encoding tab of the source settings or under the Color 
transformations bin column. For more information, refer to “Setting the Color Properties of 
Acquired Media” in the Media Composer Help.

The embedded LUT in each AMIRA clip is not editable nor can it be saved as standalone LUT.

Muting Individual Clips in the Timeline

The editing application allows you to mute individual video and audio clips in the Timeline. You 
can mute an audio or video clip in the Timeline by either right clicking on the clip and choosing 
Mute clips or selecting Mute clips from the Clip menu. 

To mute an individual clip in the Timeline:

1. Locate the audio or video clip the sequence in the Timeline that you want to mute.

2. Right click the clip and select Mute clip. (You must be in Segment mode to mute a clip.)
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The clip is then grayed out and the clip text appears in italics.

The clip plays back as filler. Muted clips can be edited like non muted clips. You can select, 
move, trim, etc. The clip keeps its timing and position in the sequence.

To unmute a muted clip in the Timeline:

1. Locate the muted audio or video clip the sequence in the Timeline.

2. Right click the clip and select Unmute clips. 

The clip is no longer muted.

Disabling a Video Track

The editing application allows you to disable a video track in the Timeline. When a video track is 
disabled, the entire input for that track is disabled. 

To disable a video track in the Timeline:

1. Click the triangle opener to access the Track Control Panel.
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2. Click the Disable Track button on the Video track you want to disable. 

The entire track is disabled and appears grayed out (or a slightly darker highlight if the track 
had a highlight color) in the Timeline. 

n When a track is disabled, you cannot render any effects on that track.  For example, if you 
disable a track and then try to render an effect on the disabled track, you will receive a “No 
effects to render” message. 

Mixing Down Multiple Audio Tracks

The editing application allows you to generate multiple audio mixes. You can map multiple 
inputs into multiple output channels. You can create up to 24 output channels for the mix. 

To create multiple audio mixes:

1. Load the sequence into the Record Monitor.

2. Select Special > Audio Mix > Multiple Mixes.

The Mutliple Mix dialog opens.
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3. Click the output channel button and select Add Output to add additional output channels or 
simply click the + button below the channel to add another output channel. You can add up 
to 24 output channels for the mix.

4. (Option) Click the button above the Output channel to apply the Master Fader effects and 
gain value to the output mix.
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5. Map the inputs for each output channel by clicking to enable the input buttons for each 
channel. Holding Shift + hovering over the inputs toggles them on and off. Alt + clicking on 
a column, toggles all inputs in that column.

6. Select the type of output for each output channel by right-clicking the channel and selecting 
either Mono, Stereo, Dual Mono, Surround 5.1, or Surround 7.1.

n Dual Mono is a stereo mix written to two mono output tracks, one for the left channel, panned 
left, and one for the right channel, panned right. The Dual Mono option counts as two tracks 
against the limit of 24 output mixes. Only odd-numbered tracks can be set to Dual Mono.

7. (Option) Right click the output channel and select Edit Mix. The Edit Mix dialog opens. You 
can name the output track as well as edit the mix mode and master fader options.

8. (Option) Save the mix configuration as a Setting. The saved settings will appear as an Audio 
Multi-Mix setting in the Project Window Settings tab. 

9. Select a drive and a bin. 

The drive is the media drive where the system stores the media files for the mixed-down 
audio. 

10. (Option) Select Use Marks. When this option is selected, your Avid editing application uses 
current IN and OUT points in the selected sequence to determine starting and ending frames 
for the mixdown.

11. (Option) Select Create New Sequence. 

12. Click Mix. 
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New master clips will be created in the selected bin for each mixdown specified in the 
setting. If you selected Create New Sequence, these clips will also be built into a new 
sequence with a track for each mix. The video and data tracks are also copied into the new 
sequence unchanged, unless you selected Exclude Video and Data Tracks.

n Opening a saved Audio Multi-Mix setting from the Project Window allows you to make changes 
to the Setting. You cannot perform a mix when selecting the setting from the Project Window. To 
choose a saved setting, access the Multiple Mix dialog from Special > Audio Mixes and then 
select the saved setting from the Select Settings pull down menu.

Grouping Stereoscopic Clips

Stereoscopic clips can now be used in group clips and used for multicam editing in the same 
manner as regular clips. You can mix both regular and stereoscopic clips in a group clip. See 
“Grouping Stereoscopic Clips” in the help. 

Selecting Filler with Segment Tools

A Timeline Settings option allows you to choose whether or not you want filler to be selected 
when using the Segment Tools. The Select Filler with Segment Tools option appears in the 
Timeline Settings Edit tab. 

To select filler when using the Segment Tools:

1. In the Project Window, click Timeline in the Settings list.

2. Click the Edit tab.

3. Enable the Select Filler with Segment Tools option.

When using the Segment tools, filler will be selected. 



Extend Shift Trim Click

16

If you do not want filler selected when using the Segment Tools, make sure the Select Filler 
with Segment Tools option is deselected.

n Using the Alt key (Windows) or Option key (Macintosh) while selecting the Select Left, Select 
Right, or Select In/Out button will exclude filler from the selection if the Select Filler with 
Segment Tools option is selected and will include filler from the selection if the Select Filler with 
Segments Tools is deselected.

Extend Shift Trim Click

This feature makes the process of adding/removing trim rollers in Trim Mode easier by NOT 
requiring users to click near a transition when the Shift key is down in Trim Mode. In the 
absence of this feature, you had to click near a cut to add rollers. Now, you can click anywhere in 
an adjoining segment when the Shift key is down. As expected, the cursor will reflect the action 
that will occur when Shift is pressed while hovering over the segment in Trim Mode. The 
transition affected by clicking will be the one closest to the cursor, thus, the transition affected 
will change at the halfway point of the segment.

This change does not affect trim click behavior when close to a transition. That behavior remains 
the same. This feature only applies as the cursor moves away from the transition.

End of Trim Indicators

The extent to which you can trim many edits at once is constrained by the amount of footage 
available to trim. When you trim to either the beginning or ending of the footage, the trim stops 
without any indication of which track ran out of footage to trim. With this release, on tracks that 
run out of room to trim, the editing application adds white brackets to the trim indicators so you 
can clearly identify the track or tracks that caused the trim to stop. All tracks that cause the trim 
to stop display these indicators.
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Merging Color-Corrected Sequences (Symphony 
Option)

You might want to work with two versions of a sequence at the same time. For example, an 
editor might work on one copy of a sequence while a colorist continues to make color 
adjustments on another copy. You can merge the two sequences to reflect the changes made on 
both copies.

The Merge Correction command merges any color corrections based on Source Tape, Clip 
Name, Master Clip, Segment, or Sub Clip relationships, or based on Program Track or Segment 
relationships, into the latest version of the edited sequence.

For example, if the editor adds new segments from source tape 1, and a color correction exists for 
that tape, your Avid editing application applies the correction to the new segments when the 
merge takes place. This is true whether the color correction was made before the editor began 
work or whether the color correction is made to the sequence while the editor is working with a 
copy of it.

You can also control which of the two copies your Avid editing application prefers if there is a 
conflict between the two copies when merging.

For an illustrated example of a typical merging workflow, see “Color Correction Merging 
Example” in the Help.
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To work with two copies of a sequence and then merge the corrections:

1. Create a first version of your sequence.

2. (Option) Click the Color Correction Mode button, for example, in the Timeline palette, and 
make initial color adjustments to the sequence.

3. Save the sequence, and then create one or two copies of the sequence.

The way you handle copies of the sequence depends on the requirements of your workflow. 
You need only two versions of the sequence — the original and one copy. For example, the 
colorist might keep the original while the editor works on the copy. However, it might be 
safer to keep the original as a backup and work with two new copies. 

For more information on saving and copying a sequence, see “Bin Procedures” in the Help.

n Name your copies clearly. For example, if you create two copies and also keep the original, you 
might use the extensions .Editor, .Colorist, and .Original to distinguish the three versions.

4. Continue to work on the two copies independently.

5. When you are ready to merge the two copies, enter Source/Record mode, for example, by 
clicking the Source/Record button.

6. Load one copy of the sequence into the Source monitor and the other into the Record 
monitor.

You can load a copy into either monitor. The only difference is that your Avid editing 
application merges into the sequence in the Record monitor unless you instruct it to create a 
new sequence for the merge in step 11.

7. Click the Color Correction Mode button, for example, in the Timeline palette.

8. Right-click in the Color Correction tool, and select Merge Correction.

n The Merge Correction command is unavailable in the Color Correction tool shortcut menu and 
you cannot select it until you load versions of a sequence in both the Source monitor and the 
Record monitor and enter Color Correction mode. 

The Merge Color Correction dialog box opens.
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9. Select the Source and Program relationships you want your Avid editing application to use 
when deciding which segments to update in the merging process.

You can merge Color Correction that was created using the Source Segment or Program 
Segment relationship. Color corrections using Source or Program segment relationships will 
be merged using the Segment’s source and timecode. In order for the merge to take place, 
there must be overlap with the source and timecode of the segments. If more than one 
segment in the source monitor overlaps the source and timecode of a segment in the record 
monitor, then the segment with the most overlap in will be used.

When merging into segments without any color correction relationships, Segment 
relationship merge is tried before other relationships when the Segment check box is 
checked in the Merge Color Correction dialog box.

Therefore, clips without any relationship correction in the record monitor will get Segment 
relationship color correction before Tape if there is any overlap with source and timecode. 
Segments that already have a relationship color correction on them will not have their type 
of relationship changed. For example, a segment will not change from Source Tape to a 
Source Segment and merges will only occur with segments in the source monitor with the 
same color correction relationship.

Segment relationships are not selected by default.

10. Click the “In case of conflict” menu, and select an option to control how the system resolves 
conflicts between the two copies of the sequence:

Option Description

Prefer Source Sequence Resolves conflicts by preferring the information in the sequence 
you loaded into the Source monitor.
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11. Select Create New Sequence if you want your Avid editing application to create a new copy 
of the sequence and merge into that copy.

If you deselect this option, your Avid editing application merges the two copies into the 
sequence that is currently in the Timeline. This is the sequence that you loaded into the 
Record monitor before entering Color Correction mode.

12. Click OK.

Your Avid editing application merges the two existing sequences, based on the options you 
have selected. The merged sequence appears in the Timeline.

Avid Image Sequencer

The Avid Image Sequencer Plug-in allows you to AMA Link to DPX files. DPX is a bitmap file 
format used to store a single frame of a motion picture or video data stream. The DPX format is 
an ANSI and SMPTE standard based on the Kodak Cineon file format. 

The Avid Image Sequencer Plug-in is automatically installed when you install the Avid editing 
application. 

The DPX plug-in can link to RGB files that have 8-bit, 10-bit (filled using Method A only), 
12-bit (filled using Method A only), and 16-bit components. It can only link to files that contain 
a single image element for example, interleaved RGB). It can link to files of either byte order 
(MSB or LSB). The DPX plug-in cannot link to files that are encrypted or run-length encoded. 
For information on Method A, see Annex C of the SMPTE spec 268M-2003.

n This release supports reading 8-bit, 10-bit, 12-bit and 16-bit DPX files. 

When linking to DPX media, first set the AIS Metadata options in the AMA Settings dialog. See 
“Linking to DPX Media with AMA” on page 20.

Linking to DPX Media with AMA

The editing application allows you to link to DPX files.

Prefer Record Sequence Resolves conflicts by preferring the information in the sequence 
you loaded into the Record monitor.

Prefer Latest Resolves conflicts by preferring the most recent information. 
This is the default setting.

Option Description
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To link to DPX files:

1. Click the Settings tab in the Project window.

2. Click AMA.

The AMA dialog opens.

3. Click the AIS Metadata tab and select the Reel name, Frame Count, and Timecode metadata 
you want to read from the DPX file. 

n DPX, Transfer and VFX bin columns have expanded from 64 characters and 7 digits to 120 
characters and 9 digits.
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4. Select File > AMA Link.

The Open dialog box opens.

5. From the Files of Type menu either select the Avid Image Sequencer (.DPX) if you are 
selecting files or Avid Image Sequencer (.Folder) if you are selecting the entire folder. 

6. Navigate to the folder that contains your DPX files. Note the following when selecting files.

Option Description

Reel name for Labroll 
column based on:

Select from where to read the Reel name. This information will appear in the 
Labroll bin column. If data exists in the Input Device field of the DPX file, this 
information will appear in the Camroll bin column after linking to the file. If 
no data exists in the Input Device field, the Camroll bin column will be empty.

• Source file name - Enabling this setting gets the Reel Name from the 
source file name. If the source file name is only numeric characters, no 
data will appear in the Labroll bin column.

• Source folder name - Enabling this setting gets the Reel Name from the 
folder name specified. When Source folder name is enabled, a pulldown 
menu becomes active. The pulldown menu is used to select a particular 
folder in the DPX folder directory structure. The directory range is one 
folder (that contains the DPX files) up to eight folders higher.

Frame Count for DPX 
column:

Select how you want Frame count to appear in the DPX bin column and 
Tracking Information. The frame count will appear as a 7 digit number in the 
DPX bin column. The DPX pre-fix is derived from the Labroll bin column. If 
no data exists in the Labroll column, then the DPX prefix will be empty.

• Start frame count at 0 - Enabling this setting starts the frame count in the 
DPX column at 0000000

• Start frame count at 1 - Enabling this setting starts the frame count in the 
DPX column at 0000001

• Convert timecode to frames - Enabling this setting extracts timecode from 
the header and converts it to frames based on the current timebase

• From the File name - Enabling this setting gets frame information from the 
file name 

Timecode for Start 
column::

Select where to read the Timecode. This information will appear in the Start 
bin column. If no timecode can be extracted from either location, the column 
will populate with the default timecode.

• Embedded in source file - Enabling this setting extracts the timecode from 
the Header file

• From file name - Enabling this setting gets the timecode from the file name
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t If you select the entire folder, all sequential files will be represented as one master clip 
in the bin. For example, selecting a folder containing the following DPX files results in 
one Kermit master clip and one Oscar master clip in the bin.

t If you select one file from a sequential group, the resulting master clip contains the 
entire group. If you select a range within the sequential group, the master clips includes 
just the selected files. For example, if you select the highlighted files below, the 
following master clips would appear in the bin: Bert (1 and 3), Bird (1, 2, 3, and 4), 
Ernie (1 and 2), Ernie (5 and 6), Kermit (1, 2, 3, and 4), Oscar (1 and 2), and the 
count.mov.)
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7.  Ctrl+click or Shift+click to select multiple files. 

8. Click Open.

The clips appear in the bin with a link icon. 

If the system cannot link a file, an error message displays informing you to open the Console 
window for more information about the file(s) in error.

For details on setting color properties, see “Setting the Color Properties of Acquired Media” 
in the Help.
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Settings Updates

The following updates were made to the AMA Settings and the Media Creation Settings:

AMA Settings: Link Options Tab

Media Creation Settings: Mixdown & Transcode and Render Tabs

Cancel an Add Marker

When adding a marker in the Marker window, selecting Cancel will remove the marker from the 
selected location.

Option Description

QuickTime Live Link Select this option if your editing workflow includes QuickTime movies where the 
number of tracks, the duration, or the edit rate, but not the file name have been 
changed in After Effects or Final Cut Pro. See “Using the QuickTime AMA Plug-In” 
in the Help.

Option Description

AMA Source 
Scaling/Quality 

Sets the playback quality for AMA plug-ins that support adjustable playback quality 
(e.g. RED, Sony HDCAM-SR, Sony RAW, AVCHD, and ARRI RAW). You can 
choose Full, Half (Best Quality), Half (Good Quality), Quarter, Eighth, Sixteenth.
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Legal Notices
Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, Inc.

This product is subject to the terms and conditions of a software license agreement provided with the software. The product may 
only be used in accordance with the license agreement.

This product may be protected by one or more U.S. and non-U.S patents. Details are available at www.avid.com/patents.

This document is protected under copyright law. An authorized licensee of Avid Media Composer may reproduce this publication for 
the licensee’s own use in learning how to use the software. This document may not be reproduced or distributed, in whole or in part, 
for commercial purposes, such as selling copies of this document or providing support or educational services to others. This 
document is supplied as a guide for Avid Media Composer. Reasonable care has been taken in preparing the information it contains. 
However, this document may contain omissions, technical inaccuracies, or typographical errors. Avid Technology, Inc. does not 
accept responsibility of any kind for customers’ losses due to the use of this document. Product specifications are subject to change 
without notice.

Copyright © 2014 Avid Technology, Inc. and its licensors. All rights reserved.

The following disclaimer is required by Apple Computer, Inc.:
APPLE COMPUTER, INC. MAKES NO WARRANTIES WHATSOEVER, EITHER EXPRESS OR IMPLIED, REGARDING THIS 
PRODUCT, INCLUDING WARRANTIES WITH RESPECT TO ITS MERCHANTABILITY OR ITS FITNESS FOR ANY PARTICULAR 
PURPOSE. THE EXCLUSION OF IMPLIED WARRANTIES IS NOT PERMITTED BY SOME STATES. THE ABOVE EXCLUSION 
MAY NOT APPLY TO YOU. THIS WARRANTY PROVIDES YOU WITH SPECIFIC LEGAL RIGHTS. THERE MAY BE OTHER 
RIGHTS THAT YOU MAY HAVE WHICH VARY FROM STATE TO STATE.

The following disclaimer is required by Sam Leffler and Silicon Graphics, Inc. for the use of their TIFF library:
Copyright © 1988–1997 Sam Leffler 
Copyright © 1991–1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software [i.e., the TIFF library] and its documentation for any purpose is 
hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the 
software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or 
publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED “AS-IS” AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, 
INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR 
CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR 
PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING 
OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

The following disclaimer is required by the Independent JPEG Group:
This software is based in part on the work of the Independent JPEG Group.

This Software may contain components licensed under the following conditions:
Copyright (c) 1989 The Regents of the University of California. All rights reserved. 

Redistribution and use in source and binary forms are permitted provided that the above copyright notice and this paragraph are 
duplicated in all such forms and that any documentation, advertising materials, and other materials related to such distribution and 
use acknowledge that the software was developed by the University of California, Berkeley. The name of the University may not be 
used to endorse or promote products derived from this software without specific prior written permission. THIS SOFTWARE IS 
PROVIDED ``AS IS'' AND WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, WITHOUT LIMITATION, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. 

Copyright (C) 1989, 1991 by Jef Poskanzer. 

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby 
granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice 
appear in supporting documentation. This software is provided "as is" without express or implied warranty. 

Copyright 1995, Trinity College Computing Center. Written by David Chappell. 

http://www.avid.com/US/about-avid/legal-notices/patent-marking
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Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby 
granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice 
appear in supporting documentation. This software is provided "as is" without express or implied warranty. 

Copyright 1996 Daniel Dardailler. 

Permission to use, copy, modify, distribute, and sell this software for any purpose is hereby granted without fee, provided that the 
above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting 
documentation, and that the name of Daniel Dardailler not be used in advertising or publicity pertaining to distribution of the software 
without specific, written prior permission. Daniel Dardailler makes no representations about the suitability of this software for any 
purpose. It is provided "as is" without express or implied warranty. 

Modifications Copyright 1999 Matt Koss, under the same license as above. 

Copyright (c) 1991 by AT&T. 

Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this entire 
notice is included in all copies of any software which is or includes a copy or modification of this software and in all copies of the 
supporting documentation for such software. 

THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY. IN PARTICULAR, 
NEITHER THE AUTHOR NOR AT&T MAKES ANY REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING THE 
MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.

This product includes software developed by the University of California, Berkeley and its contributors.

The following disclaimer is required by Nexidia Inc.:
© 2010 Nexidia Inc.  All rights reserved, worldwide.  Nexidia and the Nexidia logo are trademarks of Nexidia Inc. All other 
trademarks are the property of their respective owners.  All Nexidia materials regardless of form, including without limitation, 
software applications, documentation and any other information relating to Nexidia Inc., and its products and services are the 
exclusive property of Nexidia Inc. or its licensors.  The Nexidia products and services described in these materials may be covered 
by Nexidia's United States patents: 7,231,351; 7,263,484; 7,313,521; 7,324,939; 7,406,415, 7,475,065; 7,487,086 and/or other 
patents pending and may be manufactured under license from the Georgia Tech Research Corporation USA. 

The following disclaimer is required by Paradigm Matrix:
Portions of this software licensed from Paradigm Matrix.

The following disclaimer is required by Ray Sauers Associates, Inc.:
“Install-It” is licensed from Ray Sauers Associates, Inc. End-User is prohibited from taking any action to derive a source code 
equivalent of “Install-It,” including by reverse assembly or reverse compilation, Ray Sauers Associates, Inc. shall in no event be liable 
for any damages resulting from reseller’s failure to perform reseller’s obligation; or any damages arising from use or operation of 
reseller’s products or the software; or any other damages, including but not limited to, incidental, direct, indirect, special or 
consequential Damages including lost profits, or damages resulting from loss of use or inability to use reseller’s products or the 
software for any reason including copyright or patent infringement, or lost data, even if Ray Sauers Associates has been advised, 
knew or should have known of the possibility of such damages.

The following disclaimer is required by Videomedia, Inc.:
“Videomedia, Inc. makes no warranties whatsoever, either express or implied, regarding this product, including warranties with 
respect to its merchantability or its fitness for any particular purpose.”

“This software contains V-LAN ver. 3.0 Command Protocols which communicate with V-LAN ver. 3.0 products developed by 
Videomedia, Inc. and V-LAN ver. 3.0 compatible products developed by third parties under license from Videomedia, Inc. Use of this 
software will allow “frame accurate” editing control of applicable videotape recorder decks, videodisc recorders/players and the like.” 

The following disclaimer is required by Altura Software, Inc. for the use of its Mac2Win software and Sample Source 
Code:
©1993–1998 Altura Software, Inc.

The following disclaimer is required by Ultimatte Corporation:
Certain real-time compositing capabilities are provided under a license of such technology from Ultimatte Corporation and are 
subject to copyright protection.

The following disclaimer is required by 3Prong.com Inc.:
Certain waveform and vector monitoring capabilities are provided under a license from 3Prong.com Inc.



Cancel an Add Marker

28

The following disclaimer is required by Interplay Entertainment Corp.:
The “Interplay” name is used with the permission of Interplay Entertainment Corp., which bears no responsibility for Avid products.

This product includes portions of the Alloy Look & Feel software from Incors GmbH.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/).

© DevelopMentor

This product may include the JCifs library, for which the following notice applies:
JCifs © Copyright 2004, The JCIFS Project, is licensed under LGPL (http://jcifs.samba.org/). See the LGPL.txt file in the Third Party 
Software directory on the installation CD.

Avid Interplay contains components licensed from LavanTech. These components may only be used as part of and in connection 
with Avid Interplay.

Attn. Government User(s). Restricted Rights Legend
U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or 
“commercial computer software documentation.” In the event that such Software or documentation is acquired by or on behalf of a 
unit or agency of the U.S. Government, all rights with respect to this Software and documentation are subject to the terms of the 
License Agreement, pursuant to FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.

Trademarks
003, 192 Digital I/O, 192 I/O, 96 I/O, 96i I/O, Adrenaline, AirSpeed, ALEX, Alienbrain, AME, AniMatte, Archive, Archive II, Assistant 
Station, AudioPages, AudioStation, AutoLoop, AutoSync, Avid, Avid Active, Avid Advanced Response, Avid DNA, Avid DNxcel, Avid 
DNxHD, Avid DS Assist Station, Avid Liquid, Avid Media Engine, Avid Media Processor, Avid MEDIArray, Avid Mojo, Avid Remote 
Response, Avid Unity, Avid Unity ISIS, Avid VideoRAID, AvidRAID, AvidShare, AVIDstripe, AVX, Axiom, Beat Detective, Beauty 
Without The Bandwidth, Beyond Reality, BF Essentials, Bomb Factory, Boom, Bruno, C|24, CaptureManager, ChromaCurve, 
ChromaWheel, Cineractive Engine, Cineractive Player, Cineractive Viewer, Color Conductor, Command|24, Command|8, Conectiv, 
Control|24, Cosmonaut Voice, CountDown, d2, d3, DAE, Dazzle, Dazzle Digital Video Creator, D-Command, D-Control, Deko, 
DekoCast, D-Fi, D-fx, Digi 003, DigiBase, DigiDelivery, Digidesign, Digidesign Audio Engine, Digidesign Development Partners, 
Digidesign Intelligent Noise Reduction, Digidesign TDM Bus, DigiLink, DigiMeter, DigiPanner, DigiProNet, DigiRack, DigiSerial, 
DigiSnake, DigiSystem, Digital Choreography, Digital Nonlinear Accelerator, DigiTest, DigiTranslator, DigiWear, DINR, DNxchange, 
DPP-1, D-Show, DSP Manager, DS-StorageCalc, DV Toolkit, DVD Complete, D-Verb, Eleven, EM, Euphonix, EUCON, EveryPhase, 
Expander, ExpertRender, Fader Pack, Fairchild, FastBreak, Fast Track, Film Cutter, FilmScribe, Flexevent, FluidMotion, Frame 
Chase, FXDeko, HD Core, HD Process, HDPack, Home-to-Hollywood, HYBRID, HyperControl, HyperSPACE, HyperSPACE 
HDCAM, iKnowledge, Image Independence, Impact, Improv, iNEWS, iNEWS Assign, iNEWS ControlAir, Instantwrite, Instinct, 
Intelligent Content Management, Intelligent Digital Actor Technology, IntelliRender, Intelli-Sat, Intelli-sat Broadcasting Recording 
Manager, InterFX, Interplay, inTONE, Intraframe, iS Expander, ISIS, IsoSync, iS9, iS18, iS23, iS36, ISIS, IsoSync, KeyRig, 
KeyStudio, LaunchPad, LeaderPlus, LFX, Lightning, Link & Sync, ListSync, LKT-200, Lo-Fi, Luna, MachineControl, Magic Mask, 
Make Anything Hollywood, make manage move | media, Marquee, MassivePack, Massive Pack Pro, M-Audio, M-Audio Micro, 
Maxim, Mbox, Media Composer, MediaFlow, MediaLog, MediaMatch, MediaMix, Media Reader, Media Recorder, MEDIArray, 
MediaServer, MediaShare, MetaFuze, MetaSync, MicroTrack, MIDI I/O, Midiman, Mix Rack, MixLab, Moviebox, Moviestar, 
MultiShell, NaturalMatch, NewsCutter, NewsView, Nitris, NL3D, NLP, Nova, NRV-10 interFX, NSDOS, NSWIN, Octane, OMF, OMF 
Interchange, OMM, OnDVD, Open Media Framework, Open Media Management, Ozone, Ozonic, Painterly Effects, Palladium, 
Personal Q, PET, Podcast Factory, PowerSwap, PRE, ProControl, ProEncode, Profiler, Pro Tools LE, Pro Tools M-Powered, Pro 
Transfer, Pro Tools, QuickPunch, QuietDrive, Realtime Motion Synthesis, Recti-Fi, Reel Tape Delay, Reel Tape Flanger, Reel Tape 
Saturation, Reprise, Res Rocket Surfer, Reso, RetroLoop, Reverb One, ReVibe, Revolution, rS9, rS18, RTAS, Salesview, Sci-Fi, 
Scorch, Scorefitter, ScriptSync, SecureProductionEnvironment, Serv|LT, Serv|GT, Session, Shape-to-Shape, ShuttleCase, Sibelius, 
SIDON, SimulPlay, SimulRecord, Slightly Rude Compressor, Smack!, Soft SampleCell, Soft-Clip Limiter, Solaris, SoundReplacer, 
SPACE, SPACEShift, SpectraGraph, SpectraMatte, SteadyGlide, Streamfactory, Streamgenie, StreamRAID, Strike, Structure, 
Studiophile, SubCap, Sundance Digital, Sundance, SurroundScope, Symphony, SYNC HD, Synchronic, SynchroScope, SYNC I/O, 
Syntax, TDM FlexCable, TechFlix, Tel-Ray, Thunder, Titansync, Titan, TL Aggro, TL AutoPan, TL Drum Rehab, TL Everyphase, TL 
Fauxlder, TL In Tune, TL MasterMeter, TL Metro, TL Space, TL Utilities, tools for storytellers, Torq, Torq Xponent, Transfuser, Transit, 
TransJammer, Trigger Finger, Trillium Lane Labs, TruTouch, UnityRAID, Vari-Fi, Velvet, Video the Web Way, VideoRAID, 
VideoSPACE, VideoSpin, VTEM, Work-N-Play, Xdeck, X-Form, Xmon, XPAND!, Xponent, X-Session, and X-Session Pro are either 
registered trademarks or trademarks of Avid Technology, Inc. in the United States and/or other countries.

Adobe and Photoshop are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or 
other countries. Apple and Macintosh are trademarks of Apple Computer, Inc., registered in the U.S. and other countries. Windows 
is either a registered trademark or trademark of Microsoft Corporation in the United States and/or other countries. All other 
trademarks contained herein are the property of their respective owners. 

http://www.apache.org/
http://jcifs.samba.org/
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Footage
Arri — Courtesy of Arri/Fauer — John Fauer, Inc.
Bell South “Anticipation” — Courtesy of Two Headed Monster — Tucker/Wayne Atlanta/GMS.
Canyonlands — Courtesy of the National Park Service/Department of the Interior.
Eco Challenge British Columbia — Courtesy of Eco Challenge Lifestyles, Inc., All Rights Reserved. 
Eco Challenge Morocco — Courtesy of Discovery Communications, Inc.
It’s Shuttletime — Courtesy of BCP & Canadian Airlines. 
Nestlé Coffee Crisp — Courtesy of MacLaren McCann Canada. 
Saturn “Calvin Egg” — Courtesy of Cossette Communications. 
“Tigers: Tracking a Legend” — Courtesy of www.wildlifeworlds.com, Carol Amore, Executive Producer.
"The Big Swell" — Courtesy of Swell Pictures, Inc.
Windhorse — Courtesy of Paul Wagner Productions.

Arizona Images — KNTV Production — Courtesy of Granite Broadcasting, Inc., 
Editor/Producer Bryan Foote.
Canyonlands — Courtesy of the National Park Service/Department of the Interior.
Ice Island — Courtesy of Kurtis Productions, Ltd.
Tornados + Belle Isle footage — Courtesy of KWTV News 9.
WCAU Fire Story — Courtesy of NBC-10, Philadelphia, PA.
Women in Sports – Paragliding — Courtesy of Legendary Entertainment, Inc.
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